MATLAB

The Language of Technical Computing

Computation
Visualization

Programming

Using MATLAB® Graphics .-.‘\The MathWorks

Version 7



X LB

How to Contact The MathWorks:

www . mathworks.com
comp.soft-sys.matlab

support@mathworks.com
suggest@mathworks.com
bugs@mathworks.com

Web
Newsgroup

Technical support
Product enhancement suggestions
Bug reports

doc@mathworks.com
service@mathworks.com
info@mathworks.com

Documentation error reports
Order status, license renewals, passcodes
Sales, pricing, and general information

508-647-7000 Phone
508-647-7001 Fax
The MathWorks, Inc. Mail

3 Apple Hill Drive
Natick, MA 01760-2098

For contact information about worldwide offices, see the MathWorks Web site.

Using MATLAB Graphics
© COPYRIGHT 1984 - 2005 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be used
or copied only under the terms of the license agreement. No part of this manual may be photocopied or repro-
duced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation by,
for, or through the federal government of the United States. By accepting delivery of the Program or Docu-
mentation, the government hereby agrees that this software or documentation qualifies as commercial
computer software or commercial computer software documentation as such terms are used or defined in
FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and conditions of this
Agreement and only those rights specified in this Agreement, shall pertain to and govern the use, modifica-
tion, reproduction, release, performance, display, and disclosure of the Program and Documentation by the
federal government (or other entity acquiring for or through the federal government) and shall supersede any
conflicting contractual terms or conditions. If this License fails to meet the government's needs or is incon-
sistent in any respect with federal procurement law, the government agrees to return the Program and Docu-
mentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB, Simulink, Stateflow, Handle Graphics, Real-Time Workshop, and xPC TargetBox are registered
trademarks of The MathWorks, Inc. Other product or brand names are trademarks or registered trademarks
of their respective holders.

Patents

The MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.



Revision History

January 1997
January 1998
January 1999
September 2000
June 2001

July 2002

June 2004
October 2004
March 2005
June 2005
September 2005

First printing
Second printing
Third printing
Fourth printing
Online only
Online only
Fifth printing
Online only
Online only
Sixth printing
Online only

New for MATLAB 5.1

Revised for MATLAB 5.2

Revised for MATLAB 5.3 (Release 11)
Revised for MATLAB 6.0 (Release 12)
Revised for MATLAB 6.1 (Release 12.1)
Revised for MATLAB 6.5 (Release 13)
Revised for MATLAB 7.0 (Release 14)
Revised for MATLAB 7.0.1 (Release 14SP1)
Revised for MATLAB 7.0.4 (Release 14SP2)
Minor revision for MATLAB 7.0.4

Minor revision for MATLAB 7.1 (Release 14SP3)






Graphics

1]

MATLAB Plotting Tools

AnatomyofaGraph ................................... 1-2
Figure Toolbars ......... ... ... . . i, 1-2
Plotting Tools — Interactive Plotting ................... 14
Starting the Plotting Tools ............................. 14
Plotting Tools Interface Overview ....................... 14
The Figure Palette . ... ....... ... ... ... ... ... ... ... ... 1-7
The Plot Browser ......... ... ..t 1-11
The Property Editor ................................. 1-15
Accessing All Object Properties — Property Inspector . .. ... 1-16
Example — Working with Plotting Tools ............... 1-18
AddingaSubplot ........ ... ... . 1-20
Example — Plotting Workspace Variables .............. 1-25
Plotting Expressions ...............cciiiiiiiinninn... 1-27
Example — Specifying a Data Source .................. 1-30
Creatingthe Graph ............ ... . ... ... ... .. ...... 1-30
Varying the Data Source . ............................. 1-30
Data Sources for Multiobject Graphs .................... 1-32

Example — Generating M-Code to Reproduce a Graph .. 1-34

Data Arguments .......... ... ... . ... ... 1-35
Limitations . .. ........ .0 1-35
EditingPlots .......... ... ... ... .. .. 1-36
Interactive Plot Editing . . ............................. 1-36

Contents




ii

Contents

Using Functions to Edit Graphs ........................ 1-36

Using Plot EditMode ................................. 1-37
Starting Plot Edit Mode .. ................. ... ......... 1-38
Exiting Plot Edit Mode ................. ... ... . ....... 1-38
Selecting Objectsina Graph . .......................... 1-38
Cutting, Copying, and Pasting Objects . .................. 1-39
Moving and Resizing Objects .......................... 1-39
Setting Object Properties . ............................. 1-40
Undo/Redo — Eliminating Mistakes . .................... 1-40

Saving Your Work . .......... ... ... ... .. ... ... .. ..., 1-42
Saving a Graph in MAT-File Format .................... 1-42
Saving to a Different Format — Exporting Figures ........ 1-43
Printing Figures . .......... ... ... .. . . . . . . .. 1-44
Generating an M-File to Recreate a Graph ............... 1-44

Data Exploration Tools

2

Ways to Explore GraphicalData ........................ 2-2
Typesof Tools . . ... et 2-2
Data Cursor — Displaying Data Values Interactively .. ... 2-3
Enabling Data Cursor Mode ............................ 2-3
Display Style — Datatip or Cursor Window . .. ............. 2-7
Selection Style — Select Data Points or
Interpolate Pointson Graph ............................ 2-8
Exporting Data Value to Workspace Variable .............. 2-9
Zoomingin2-Dand3-D ............................... 2-11
Zoomingin 2-DViews ................ ... 2-11
Panning — Moving Your View of the Graph ............ 2-14
2-Dvs.3-DPanning ................0 ... 2-14
Rotate 3D — Interactive Rotation of 3-D Views ......... 2-15



Enabling Rotate 3D .......... .. ... ... .. ... . . . . . ... .. 2-15

Selecting Predefined Views ............................ 2-15
Rotation Style for Complex Graphs ..................... 2-15
Undo/Redo — Eliminating Mistakes . .................... 2-17
Annotating Graphs
3

How to Annotate Graphs . . ............................. 3-2
Graph Annotation Features ............................ 3-2
Enclosing Regions of a Graph in a Rectangle or an Ellipse . ... 3-5
Textbox Annotations ..................o it 3-7
Annotation Lines and Arrows .......................... 3-10
Adding a Colorbartoa Graph .......................... 3-13
Adding aLegendtoa Graph ........................... 3-15
Pinning — Attaching to a Point in the Graph ............. 3-17
Alignment Tool — Aligning and Distributing Objects . ... 3-20
Example — Vertical Distribute, Horizontal Align .......... 3-21
Align/Distribute Menu Options ......................... 3-23
Snap to Grid — Aligning Objectsona Grid ............... 3-25
Adding Titlesto Graphs .............................. 3-27
Using the Title Option on the Insert Menu ............... 3-28
Using the Property Editor to Adda Title ................. 3-28
Using the title Function . . . ............................ 3-29
Adding Axis LabelstoGraphs ......................... 3-30
Using the Label Options on the Insert Menu . ............. 3-31
Using the Property Editor to Add Axis Labels ............. 3-31
Using Axis-Label Commands .......................... 3-33
Adding Text Annotationsto Graphs .................... 3-36
Creating Text Annotations with the text or gtext Command . 3-37
Text Alignment ............ ... ... ... 3-40
Example — Aligning Text ............................. 3-41
Editing Text Objects .......... ... ..., 3-42

iii



iv

Contents

Mathematical Symbols, Greek Letters, and TEX Characters . 3-43

Using Character and Numeric Variables in Text .......... 3-45
Example — Multiline Text ............................ 3-46
Drawing TextinaBox .................... .. ... ....... 3-47
Adding Arrows and Lines to Graphs ................... 3-49
Creating Arrows and Lines in Plot Editing Mode .......... 3-49
Editing Arrows and Line Annotations ................... 3-50

Basic Plotting Commands

Basic Plotting Commands . ............................. 4-2
Plotting Steps . .. ... .o 4-2
Creating LinePlots ............ ... .. ... ... ... ... 4-3
Specifying Line Style .............. ... ... ... ......... 4-5
Specifying the Color and Size of Lines .................... 4-7
Adding Plots to an Existing Graph ....................... 4-8
Plotting Only the Data Points . .......................... 4-9
Plotting Markersand Lines . . .......................... 4-10
Line Styles for Black and White Output ................. 4-11
Setting Default Line Styles ............................ 4-12

Line Plots of MatrixData ............................. 4-14

Plotting Imaginary and ComplexData ................. 4-16

Plotting with Two Y-Axes ............................. 4-17
Combining Linear and Logarithmic Axes ................. 4-17

Setting Axis Parameters .............................. 4-20
Axis Limitsand Ticks ........... .. ..., 4-20
Example — Specifying Ticks and Tick Labels ............. 4-23
Setting Aspect Ratio ................. ... ... ... . ..... 4-24

Figure Windows .......... ... .. ... ... ... ... ... 4-27
Displaying Multiple Plots per Figure .................... 4-27



Specifying the Target Axes ............... ... .. ........ 4-29
Default Color Scheme ................ ... . ... ....... 4-29

5]

Barand AreaGraphs .................... ... ... ... ..., 5-2
Types of Bar Graphs .......... ... ... ... ... .. . ..., 5-2
Stacked Bar Graphs to Show Contributing Amounts ........ 5-5
Specifying X-AxisData .............. ..., 5-7
Overlaying Plots on Bar Graphs ......................... 5-9
Area Graphs ............ .. e 5-11
Comparing Data Sets with Area Graphs ................. 5-12

PieCharts ........ ... ... . . i 5-14
Removing a Piece fromaPie Chart ..................... 5-16

Histograms . .......... ... ... .. . . . .. 5-17
Histograms in Cartesian Coordinate Systems ............. 5-17
Histograms in Polar Coordinates ....................... 5-19
Specifying Number of Bins ............................ 5-20

Discrete DataGraphs ................................. 5-22
Two-Dimensional Stem Plots .......................... 5-22
Combining Stem Plots with Line Plots ................... 5-25
Three-Dimensional Stem Plots ......................... 5-26
Stairstep Plots ......... ... .. . . . . 5-29

Direction and Velocity Vector Graphs . ................. 5-31
Compass Plots ........ ... ... .. . . i 5-31
Feather Plots .......... ... . ... 5-32
Two-Dimensional Quiver Plots ......................... 5-34
Three-Dimensional Quiver Plots . . ...................... 5-35

ContourPlots . ......... . ... ... . . 5-37
Creating Simple Contour Plots ......................... 5-37

Labeling Contours ................. ..ttt iiiiiinnn... 5-39



Filled Contours .. ... 5-40

Drawing a Single Contour Line at a Desired Level ......... 5-41
The Contouring Algorithm ............................ 5-42
Changing the Offset of a Contour ....................... 5-43
Displaying Contours in Polar Coordinates ................ 5-44
Interactive Plotting .................................. 5-48
Animation ......... ... ... ... ... 5-50
MOVIES & oot e e 5-50
Example — Visualizing an FFT asa Movie ............... 5-51
Erase Modes . ...ttt 5-52

6|

OVerVIEW . ... 6-2
Imagesin MATLAB . ........ ... ... 6-4
Bit Depth Support ......... ... .. .. . . .. 6-4
DataTypes .......coi e e 6-4
Image Types ........... it 6-6
Indexed Images ............ ..., 6-6
Intensity Images .......... ... .. .. i, 6-7
RGB (Truecolor) Images ............... ... ..., 6-9
Working with 8-Bit and 16-Bit Images .................. 6-11
8-Bit and 16-Bit Indexed Images ....................... 6-11
8-Bit and 16-Bit Intensity Images ...................... 6-12
8-Bit and 16-Bit RGBImages .......................... 6-12
Mathematical Operations Support for uint8 and uintl6 . . . .. 6-13
Other 8-Bit and 16-Bit Array Support ................... 6-13
Converting an 8-Bit RGB Image to Grayscale ............. 6-14
Summary of Image Types and Numeric Classes ........... 6-16

Reading, Writing, and Querying Graphics Image Files ... 6-17

vi Contents



Reading a GraphicsImage ............................ 6-17

Writing a Graphics Image ............................. 6-18
Subsetting a Graphics Image (Cropping) ................. 6-18
Obtaining Information About Graphics Files ............. 6-19
Displaying GraphicsImages .......................... 6-21
Summary of Image Types and Display Methods ........... 6-22
Controlling Aspect Ratio and Display Size ................ 6-22
The Image Object and Its Properties ................... 6-26
ImageCData ............ ... . ... 6-26
Image CDataMapping . ............ouuiiiueennnnennnn.. 6-26
XDataand YData . ...t 6-27
EraseMode . ....... .o e 6-29
Adding TexttoImages . ............ ... ... .. 6-30
Additional Techniques for Fast Image Updating ........... 6-32
PrintingImages .. ............. ... ... ... ... ... . ... 6-34
Converting the Data or Graphic Type of Images ........ 6-35

Printing and Exporting

7|

Overview of Printing and Exporting .................... 7-2
Print and Export Operations .. .......................... 7-2
Graphical User Interfaces .............................. 7-2
Command Line Interface ............................... 7-3
Specifying Parameters and Options ...................... 7-5
Default Settings and How to Change Them ................ 7-6

How to PrintorExport ................................ 7-9
Using Print Preview . .. ............ ... ... ... ... ..., 7-9
Printinga Figure .......... ... ... ... .. ... . . . . . . ... 7-11
PrintingtoaFile ......... ... .. ... . . . .. . . . . . ... 7-15
ExportingtoaFile .......... ... ... ... .. ... . . . ... .. 7-17
Exporting to the Windows Clipboard .................... 7-27

vii



Examples of Basic Operations ......................... 7-30

Printing a Figure at Screen Size . ....................... 7-30
Printing with a Specific Paper Size . . .................... 7-31
Printing a Centered Figure ............................ 7-32
Exporting in a Specific Graphics Format ................. 7-33
Exporting in EPS Format with a TIFF Preview ........... 7-34
Exporting a Figure to the Clipboard ..................... 7-35
Changing a Figure’s Settings .......................... 7-38
Selectingthe Figure ... .............. ... ... ... ........ 7-40
Selecting the Printer ........... ... ... ... ... ........ 7-40
Setting the Figure Size and Position .................... 7-41
Setting the Paper Sizeor Type ......................... 7-45
Setting the Paper Orientation .......................... 7-46
Selectinga Renderer ..................... ... .. ... .... 7-48
Setting the Resolution ................................ 7-51
Setting the Axes Ticks and Limits ...................... 7-54
Setting the Background Color . ......................... 7-56
Setting Line and Text Characteristics ................... 7-57
Setting the Line and Text Color ........................ 7-59
Setting CMYK Color ...............0 ... 7-61
Excluding User Interface Controls ...................... 7-62
Producing Uncropped Figures . ......................... 7-62
Choosing a Graphics Format .......................... 7-64
Frequently Used Graphics Formats ..................... 7-65
Factors to Consider in Choosing a Format ................ 7-66
Properties Affected by Choice of Format ................. 7-68
Impact of Rendering Method on the Output .............. 7-70
Description of Selected Graphics Formats ................ 7-70
How to Specify a Format for Exporting .................. 7-74
Choosing a Printer Driver ............................ 7-75
Types of Printer Drivers ................. ... ... ....... 7-75
Factors to Consider in Choosing a Driver ................. 7-76
Driver-Specific Information .. ............... ... ... ... 7-79
How to Specify the Printer DrivertoUse ................. 7-83
Troubleshooting ..................................... 7-85
Printing Problems ............ ... ... ... ... . i ... 7-86

viil Contents



Exporting Problems ............. ... ... ... .. .. . . .. .... 7-89
General Problems .......... ... ... ... ... ... . . .. . . . ... .. 7-92

Handle Graphics Objects

8|

Organization of Graphics Objects ...................... 8-3
Types of Graphics Objects ............................. 8-4
Information on Specific Graphics Objects ................. 8-4
Graphics Windows —the Figure ........................ 8-5
Figures Used for GraphingData . ........................ 8-6
Figures Used for GUIs ........... ... ..., 8-6
Root Object — the Figure Parent ........................ 8-7
More Information on Figures ........................... 8-7
Core Graphics Objects ................................. 8-8
Description of Core Graphics Objects .................... 8-11
Example — Creating Core Graphics Objects .............. 8-12
Parenting ......... ... .. ... . . . .. 8-14
High-Level Versus Low-Level .......................... 8-14
Simplified Calling Syntax .................. ... ........ 8-15
Plot Objects .......... ... ... . . .. 8-17
Creatinga Plot Object .......... ... ... ... ... . ....... 8-18
Identifying Plot Objects Programmatically ............... 8-19
Linking Graphs to Variables — Data Source Properties . . . .. 8-19
Plot Objects and Backward Compatibility ................ 8-20
Annotation Objects .. ................................. 8-22
Annotation Object Properties .......................... 8-22

Example — Enclosing Subplots with an Annotation Rectangle 8-22

Group Objects ........ ... ... ... i, 8-25
Creatinga Group ............uiiiiiiinee ... 8-25
Transforming Objects ............. ... ... ... ..... 8-26

ix



X

Contents

Example — Transforming a Hierarchy of Objects .......... 8-31

Object Properties .................. ... ... ..., 8-35
Storing Object Information ............................ 8-35
ChangingValues ............ ... .. ..., 8-35
Default Values ............ ... .. .. ... 8-35
Properties Common to All Objects ...................... 8-36

Setting and Querying Property Values ................. 8-38
Setting Property Values ................... ... ........ 8-38
Querying Property Values . ............... ... .......... 8-40
Factory-Defined Property Values ....................... 8-42

Setting Default Property Values ... .................... 8-43
How MATLAB Searches for Default Values ... ............ 8-43
Defining Default Values .............................. 8-45
Examples — Setting Default Line Styles ................. 8-46

Accessing Object Handles . ............................ 8-50
Special Object Handles .................... ... . ....... 8-50
The Current Figure, Axes, and Object ................... 8-50
Searching for Objects by Property Values — findobj ........ 8-52
Copying Objects . ...ttt 8-56
Deleting Objects . ........ ... .. 8-58

Controlling GraphicsOQutput .......................... 8-60
Specifying the Target for Graphics Output ............... 8-60
Preparing Figures and Axes for Graphics ................ 8-61
Targeting Graphics Output with newplot ................ 8-62
Example — Usingnewplot ............................ 8-64
Testing for Hold State ................... ... .. ........ 8-66
Protecting Figuresand Axes ................ ... ........ 8-67
The Figure Close Request Function ..................... 8-69
Handle Validity Versus Handle Visibility ................ 8-70

Saving Handlesin M-Files ............................ 8-71

Properties Changed by Built-In Functions ............. 8-72



Objects That Can Contain Other Objects ............... 8-75

Using Panel Containers in Figures — Uipanels ........... 8-75
Example — Using Figure Panels ....................... 8-76
Grouping Objects Within Axes — hgtransform ............ 8-80
Callback Properties for Graphics Objects .............. 8-84
Graphics Object Callbacks . .. .......................... 8-84
User Interface Object Callbacks ........................ 8-84
Figure Callbacks ............. ... .. .. . ... 8-84
Function Handle Callbacks ........................... 8-86
Function Handle Syntax .............................. 8-86
Why Use Function Handle Callbacks .................... 8-88
Example — Using Function Handlesin GUIs ........... 8-90
Complete Example Code ................... ... ........ 8-90
The GUI Layout ............ ... .. 8-90
Initialize the GUIL ... ... ... .. .. .. . . . .. 8-91
The Callback Functions . ........... ... ... .. ... ..... 8-92
Optimizing Graphics Performance . .................... 8-95
General Performance Guidelines ....................... 8-95
Disable Automatic Modes ............. ... ... ... ..., 8-96
Changing Graph Data Rapidly ......................... 8-98
Performance of Bit-Mapped Images .................... 8-101
Performance of Patch Objects ......................... 8-101
Performance of Surface Objects ....................... 8-102
Figure Properties

FigureObjects .......... ... .. ... . . ... 9-2
Related Information About Figures ...................... 9-2
Docking Figuresin the Desktop ........................ 9-3
Figure Properties That Affect Docking . ................... 9-4

Creating a Nondockable Figure ......................... 94



xii

Contents

Positioning Figures ................ ... ... ... .......... 9-5

The Position Vector ........... .. ... .. 9-5
Example — Specifying Figure Position ................... 9-7
Figure Colormaps — The Colormap Property ............ 9-9
Specifying the Figure Colormap ......................... 9-9
Selecting Drawing Methods ........................... 9-10
Backing Store . ........ ... ... . ... 9-10
Double Buffering ........... ... ... ... ... . ... . . ... 9-10
Selectinga Renderer ................ ... ... ... . . ...... 9-11
Specifying the Figure Pointer ......................... 9-13
Defining Custom Pointers ............................. 9-14
Axes Properties

10

Axes Objects — Defining Coordinate Systems for Graphs 10-2

Labeling and Appearance Properties .................. 10-3
Creating Axes with Specific Characteristics .............. 10-3
Positioning Axes .......... ... ... .. ..., 10-5
The Position Vector ........... ... ... ... ... .. .. 10-5
Position Units . ........ .. ... i 10-6
Automatic AxesResize ............... ... . ... .. ..., 10-7
Multiple Axes per Figure ............................ 10-13
Placing Text Outsidethe Axes ........................ 10-13
Multiple Axes for Different Scaling .................... 10-14
Individual Axis Control .............................. 10-16
Setting Axis Limits ................ ... ... ... ... ..... 10-17
Setting Tick Mark Locations .......................... 10-18
Changing Axis Direction ............................. 10-19



Using Multiple X-and Y-Axes . . ....................... 10-22

Example — Double Axis Graphs . ...................... 10-22
Automatic-Mode Properties .......................... 10-25
Colors Controlled by Axes ........................... 10-28

Specifying Axes Colors . .......... ... .. 10-28

Axes Color Limits — the CLim Property ................ 10-30

Example — Simulating Multiple Colormaps in a Figure ... 10-31

Calculating Color Limits ............................. 10-32

Defining the Color of Lines for Plotting ................. 10-35

Line Styles Used for Plotting — LineStyleOrder .......... 10-37

3-D Visualization

Creating 3-D Graphs

11

ATypical3-DGraph .................................. 11-2
Line Plotsof3-DData ................................ 11-3
Representing a Matrixasa Surface .................... 11-5
Mesh and Surface Plots ................. ... ... ........ 11-5
Visualizing Functions of Two Variables .................. 11-6
Surface Plots of Nonuniformly Sampled Data ............. 11-8
ParametricSurfaces . .......... .. ... . i .. 11-10
Hidden Line Removal ............................... 11-12
Coloring Mesh and SurfacePlots ..................... 11-13
Coloring Techniques ..............c.tiiiiiiiinnnn... 11-13
Typesof ColorData ................ ... ... 11-13
Colormaps .« ..ttt . 11-14
Indexed Color Surfaces — Direct and Scaled Colormapping 11-16
Example — Mapping Surface Curvature to Color ......... 11-17

xiii



Xiv  Contents

Altering Colormaps . ...........iiiiiiiiiinnennn. 11-19

Truecolor Surfaces ...............cciiiiiinnnn... 11-20
Texture Mapping ............uiiiiiiiinennnnnnn. 11-22
Defining the View

Viewing Overview .. .......... ... . .0, 12-2
Positioning the Viewpoint ............................. 12-2
Setting the Aspect Ratio .............................. 12-2
Default Views . ... i i 12-3
Setting the Viewpoint with Azimuth and Elevation ..... 12-4
Azimuth and Elevation ............................... 124
Defining Scenes with Camera Graphics ................ 12-8
View Control with the Camera Toolbar ................ 12-9
Camera Toolbar ............ ... ..., 12-9
Camera Motion Controls ............................. 12-12
Orbit Camera .............c.0 .. 12-12
Orbit Scene Light ............ ... ... ... .. .. ....... 12-13
Pan/Tilt Camera . .............. 0., 12-14
Move Camera Horizontally/Vertically .................. 12-15
Move Camera Forward and Backward .................. 12-15
Zoom Camera .. ......oiiti e 12-17
CameraRoll ........ ... ... .. ... . . .. 12-18
Camera Graphics Functions ......................... 12-19
Example — Dollying the Camera ..................... 12-20
Example — Moving the Camera Through a Scene ...... 12-22
Summary of Techniques ............................. 12-22
Graphing the Volume Data ........................... 12-22
Setting UptheView .......... ... ... ... .. ... ...... 12-23
Specifying the Light Source . .. ........................ 12-23



Selectinga Renderer .................. ... ... ........ 12-24

Defining the Camera Path as a Stream Line ............. 12-24
Implementing the Fly-Through ........................ 12-24
Low-Level Camera Properties ........................ 12-28
Default Viewpoint Selection .......................... 12-29
Moving In and Outon the Scene ... .................... 12-29
Making the Scene Larger or Smaller ................... 12-31
Revolving Around the Scene .......................... 12-31
Rotation Without Resizing of Graphics Objects ........... 12-31
Rotation About the Viewing Axis ...................... 12-32
View Projection Types . .............................. 12-34
Projection Types and Camera Location ................. 12-35
Understanding Axes Aspect Ratio .................... 12-39
Stretch-to-Fill . ..... ... ... .. .. . . 12-39
Specifying Axis Scaling ............... ... ... ... ..... 12-39
Specifying Aspect Ratio . ............................. 12-40
Example — axis Command Options .................... 12-41
Additional Commands for Setting Aspect Ratio........... 12-43
Axes Aspect Ratio Properties ........................ 12-44
Default Aspect Ratio Selection ........................ 12-45
Overriding Stretch-to-Fill ............................ 12-47
Effects of Setting Aspect Ratio Properties ............... 12-48
Example — Displaying Cross-Sections of Surfaces ........ 12-52
Example — Displaying Real Objects ................... 12-53

Lighting as a Visualization Tool

Lighting Overview ............. .. ... ... ... ... 13-2
Lighting Examples . .......... .. ... ... ... . . . ... 13-2
LightingCommands .................................. 13-3

XV



xvi

Contents

Light Objects ......... ... ... .. . . . .. 13-4

14

Adding LightstoaScene ............................. 13-5
Properties That Affect Lighting ....................... 13-8
Selecting a Lighting Method ......................... 13-10
Face and Edge Lighting Methods ...................... 13-10
Reflectance Characteristics of Graphics Objects ....... 13-11
Specular and Diffuse Reflection ....................... 13-11
Ambient Light ............ ... ... .. .. ... ... ... .... 13-12
Specular Exponent . .............. ... ... ... .. .. ..., 13-13
Specular Color Reflectance ........................... 13-14
Back Face Lighting ................... .. ... . ........ 13-14
Positioning Lights in Data Space ...................... 13-17
Transparency

Making Objects Transparent .......................... 14-2
Specifying Transparency . ..............couiiiiiiinnn... 14-3
Specifying a Single Transparency Value ............... 14-5
Example — Transparent Isosurface ..................... 14-5
Mapping Data to Transparency — Alpha Data .......... 14-7
Size of the Alpha Data Array .......................... 14-8
Mapping Alpha Data to the Alphamap ................... 14-8
Example — Mapping Data to Color or Transparency ....... 14-8
Selecting an Alphamap .............................. 14-10
Example — Modifying the Alphamap ................... 14-12



Creating 3-D Models with Patches

15

Introduction to Patch Objects ......................... 15-2
Defining Patches ........... ... ... ... ... ... ... .. ..... 15-2
Behavior of the patch Function ......................... 15-2
Creating a Single Polygon ............................. 154

Multifaceted Patches ................................. 15-6
Example — DefiningaCube ........................... 15-6

Specifying Patch Coloring ........................... 15-11
Patch Color Properties .. ............... ... ..., 15-11

Patch Edge Coloring ................................ 15-13
Example — Specifying Flat Edge and Face Coloring ...... 15-13
Coloring Edges with Shared Vertices ................... 15-14

Interpreting Indexed and TruecolorData ............. 15-16
Indexed ColorData ................... ... ... ...... 15-16
Truecolor Patches . ......... ... ... ... ... ... ... ..., 15-19
Interpolating in Indexed Color Versus Truecolor ......... 15-19

Volume Visualization Techniques

16 |

Overview of Volume Visualization ..................... 16-3
Examples of Volume Data ............................. 16-3
Selecting Visualization Techniques ..................... 16-3
Steps to Create a Volume Visualization .................. 16-4

Volume Visualization Functions . ...................... 16-5
Functions for ScalarData ............................. 16-5
Functions for Vector Data ............................. 16-6

Visualizing Scalar Volume Data ....................... 16-7
Techniques for Visualizing ScalarData .................. 16-7

xvii



xXViil Contents

Visualizing MRIData ................................. 16-8

Example — Ways to Display MRI Data .................. 16-8
Exploring Volumes with Slice Planes ................. 16-14
Example — Slicing Fluid Flow Data . ................... 16-14
Modifying the Color Mapping ......................... 16-17
Connecting Equal Values with Isosurfaces ............ 16-19
Example — Isosurfaces in Fluid Flow Data .............. 16-19
Isocaps Add Context to Visualizations ................ 16-21
Defining Isocaps . . ... ovi it 16-22
Example — Adding Isocaps to an Isosurface ............. 16-23
Visualizing Vector Volume Data ... ................... 16-26
Using Scalar Techniques with Vector Data .............. 16-26
Specifying Starting Points for Stream Plots ... ........... 16-27
Accessing Subregions of Volume Data .................. 16-30
Stream Line Plots of Vector Data .................... 16-32
Displaying Curl with Stream Ribbons ................. 16-34
Displaying Divergence with Stream Tubes ............ 16-36
Creating Stream Particle Animations ................. 16-39
Vector Field Displayed with Cone Plots ............... 16-42
Index




Graphics

This section discusses techniques for plotting data and provides examples showing how to plot,

annotate, and print graphs.

MATLAB Plotting Tools
Data Exploration Tools
Annotating Graphs

Basic Plotting Commands

Creating Specialized Plots

Displaying Bit-Mapped Images
Printing and Exporting

Handle Graphics Objects
Figure Properties
Axes Properties

Related Information

Creating plots and setting graphic object properties

Tools to extract information from graphs interactively
Adding annotations, axis labels, titles, and legends to graphs
Plotting vector and matrix data in 2-D representations

Creating bar graphs, histograms, contour plots, and other
specialized plots

Displaying and modifying bit-mapped images with MATLAB®

Printing graphs on paper and exporting graphs to standard
graphic file formats

MATLAB graphics objects and properties
How to use figure properties

How to use axes properties

These other sections provide additional information about plotting.

3-D Visualization

Using viewing and lighting techniques to achieve complex
graphic effects

Creating Graphical User Interfaces How to include menus, push buttons, text boxes, and other

user interface objects in MATLAB applications






MATLAB Plotting Tools

Anatomy of a Graph (p. 1-2)

Plotting Tools — Interactive Plotting
(p. 1-4)

Example — Working with Plotting
Tools (p. 1-18)

Example — Plotting Workspace
Variables (p. 1-25)

Example — Specifying a Data Source
(p. 1-30)

Example — Generating M-Code to
Reproduce a Graph (p. 1-34)

Editing Plots (p. 1-36)
Using Plot Edit Mode (p. 1-37)
Saving Your Work (p. 1-42)

Describes the basic components of a MATLAB graph

Introduces the interactive tools you can use for creating
graphs and setting properties

Shows how to work with the Plotting Tools

Access workspace variables from the Plotting Tools

Link graph data to workspace variables

Save all the property settings and other steps used to
create a graph

Overview of plot editing options.
Modify graph appearance interactively
Ways to save graphs
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Anatomy of a Graph
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MATLAB® plotting functions and tools direct their output to a window that is
separate from the Command Window. In MATLAB this window is referred to
as a figure. For example, the following picture illustrates a graph of the Bessel
function, highlighting the basic components of the graph.
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By default, MATLAB uses line style and color to distinguish the data sets
plotted in the graph. However, you can change the appearance of these graphic
components or add annotations to the graph to help explain your data for
presentation.

Figure Toolbars

The figure’s default toolbar provides shortcuts to commonly used features. The
following picture shows the features available from this toolbar.



Anatomy of a Graph
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Note that you can enable two other toolbars from the View menu:
® Camera Toolbar — Use for manipulating 3-D views. See “View Control with
the Camera Toolbar” for more information.

¢ Plot Edit Toolbar — Use for annotation and setting object properties. See
“Annotation Tools on the Plot Edit Toolbar” on page 3-2 for more
information.
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Plotting Tools — Interactive Plotting

MATLAB provides a collection of plotting tools that form an interactive
plotting environment. This environment enables you to

® Create various type of graphs

e Select variables to plot directly from a workspace browser

¢ Easily create and manipulate subplots in the figure

e Add annotations such as arrows, lines, and text

® Set properties on graphics objects

Starting the Plotting Tools

To create a figure with the plotting tools attached, use the plottools
command. You can also start the plotting tools from the figure toolbar by
clicking the Show Plot Tools icon 0

Remove the plotting tools from a figure using the Hide Plot Tools icon .

You can display the three basic plotting tools from the View menu by selecting
Figure Palette, Plot Browser, or Property Editor.

The next section describes the individual components making up the plotting
tools.

Plotting Tools Interface Overview

The Plotting Tools interface includes three panels that are associated with a
figure.

¢ Figure Palette — Use to create and arrange subplot axes, view and plot
workspace variables, and add annotations. Display the Figure Palette using
the figurepalette command.

¢ Plot Browser — Use to select and control the visibility of the axes or graphic
objects plotted in the figure. You can also add data to any selected axes by
clicking the Add Data button. Display the Plot Browser using the
plotbrowser command.

¢ Property Editor — Use to set common properties of the selected object. You
can also click the Inspector button to display the Property Inspector, which

14
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provides access to all object properties. Display the Property Editor using the
propertyeditor command.

Plotting Tools

This picture shows the plotting tools attached to a figure that contains two
subplots.

1-5



T MATLAB Plotting Tools

Figure Palette Axes subplots Lineseries selected Figure Plot Browser

2 Figure 1
Filz  Edit

O =

=0l x|

|

View Insert Toold Deskbop  ‘Window Help

Plot Browser

w fewy Subplots v axes (ho title)
v
20 sxes H»
L . 3D Axes B v axes (notitle)
B
w Yariables
B - 1%200
HE‘ xlang 1=400
1 1x400
HH y2 1200
w Annatations
\ Lire
N\ Arrow 100 150 200 250
. oo a =l Add Data...

Property Editor - Lineseries

Display Mame: I Plot Type: ILine LI Inspec‘tnr,_,A |

Refresh Data.\. |

X Data Source: I xlong LI Line: I LI I 05 LI

Y Data Source: |y1 LI Marker: Innne LI IE.D LI é =

I Data Source: I LI
Property Editor displaying lineseries (lick to add data to axes  Click to display Property
properties Inspector

1-6



Plotting Tools — Interactive Plotting

The Figure Palette

The Figure Palette contains three panels. Select the panel you want to view by

clicking the respective button, which twists down the panel and exposes its
contents.

The Figure Palette enables you to perform the following tasks with these
panels:

* New Subplots — Add 2-D or 3-D axes to the figure.

® Variables — Browse and plot workspace variables.

® Annotations — Add annotations to graphs.

Adding Subplot Axes

The New Subplots panel enables you to create a grid of either 2-D or 3-D axes.

To display the selector, click the grid icon next to the axes type. MATLAB
displays the selector grid.

As you move the cursor, squares darken to indicate the layout of axes that will

be created if you release the mouse button. Click Cancel at the bottom of the
grid to leave the figure unchanged.
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1-8

The picture above shows the New Subplots panel selected to display four
equally sized axes in the figure. Existing axes resize as required to
accommodate the new layout.

Plotting Workspace Variables

The Variables panel displays current workspace variables. Double-clicking a
variable in this panel opens that variable in the Array Editor. If you select a
variable and right-click to display the context menu, you can select a graphics
function to plot the variable.

For example, the following picture illustrates how to plot the columns of
variable Z. This is equivalent to passing a matrix to the plot function.
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The context menu contains a list of possible plot types based on the variable
you select and also enables you to perform certain operation on the variable,
such as opening it in the Array Editor, saving, copying, and so on.

Note that the context menu items may change when you select different
variables because a particular variable might be incompatible some of the plot

types.
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Drag and Drop Plotting

You can also drag the variable directly into an axes, in which case MATLAB
selects the first appropriate plot type for that variable. If there are multiple
axes, you must first select the one you want to plot in and then drag the
variable to that axes.

In the previous example, the variable Z would be plotted using the plot
function if you were to drag it into an axes.

If the desired plotting function is not available from the context menu, you can
select More Plots to display the Plot Catalog tool.

The Plot Catalog Tool

The Plot Catalog tool provides access to most of the MATLAB plotting
functions. You can type any workspace variables in the Plotted Variables
field, which are then passed to the selected plotting function as arguments.
Separate variables with a comma.

You can also enter a MATLAB expression using any workspace variables
shown in the Figure Palette.

The following picture shows the Plot Catalog tool and describes its components.
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Comma-separated list of variables or expressions is passed to Help provides information on function arguments
selected function. and links to more information.
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Adding Annotations to Graphs

The Annotations panel enables you to insert annotation objects into a plot. To
add an object, first select the object you want to add, and then click and drag
the mouse to position and size the object.

See “How to Annotate Graphs” on page 3-2 for more information about the
various types of annotation objects.

The Plot Browser

The Plot Browser provides a legend of all the graphs in the figure. It lists each
axes and the objects (lines, surfaces, etc.) used to create the graph.

For example, suppose you plot an 11-by-11 matrix z. The plot function creates
one line for each column in z.

plot(z,'DisplayName','z")

When you set the DisplayName property, the Plot Browser indicates which line
corresponds to which column.

1-11
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If you want to set the properties of an individual line, double-click on the line
in the Plot Browser. Its properties are displayed in the Property Editor, which
opens on the bottom of the figure.

You can select a line in the graph, and the corresponding entry in the Plot
Browser is highlighted, enabling you to see which column in the variable
produced the line.

Controlling Object Visibility

The check box next to each item in the Plot Browser controls the object’s
visibility. For example, suppose you want to plot only certain columns of data
in z, perhaps the positive values. You can uncheck the columns you do not want
to display. The graph updates as you uncheck each box and rescales the axes
as required.
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Deleting Objects

You can delete any selected item in the Plot Browser by selecting Delete from
the right-click context menu.

Adding Data to Axes

The Plot Browser provides the mechanism by which you add data to axes. The
procedure is as follows:

1 Select a 2-D or 3-D axes from the New Subplots subpanel.

2 After creating the axes, select it in the Plot Browser panel to enable the Add
Data button at the bottom of the panel.

3 Click the Add Data button to display the Add Data to Axes dialog.

1-13
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1-14

The Add Data to Axes dialog enables you to select a plot type and specify the
workspace variables to pass to the plotting function. You can also specify a
MATLAB expression, which is evaluated to produce the data to plot.

Selecting Workspace Variables to Create a Graph. Suppose you want to create a
surface graph from three workspace variables defining the XData, YData, and
ZData (see the surf function for more information on this type of graph).

In the workspace you have defined three variables, x, y, and z. To create the
graph, configure the Add Data to Axes dialog as shown in the following picture.

<} Add Data to Axes x|

& ]

Plot Type:

¥ Data Source: I % LI
Optional
Y Data Source: I Y LI

Optional

Kl

I Data Source: I z

Select a warable, ertype an expreszion

L]

Calar: I
Optional

Cancel |

Using a MATLAB Expression to Create a Graph. The following picture shows the Add
Data to Axes dialog specifying a workspace variable x for the plot’s x data and
a MATLAB expression (x."2 + 3*x + 5) for the y data.
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<} Add Data to Anes |
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Cancel |

You can use the default X Data value of index if you do not want to specify x
data. In this case, MATLAB plots the y data vs. the index of the y data value,
which is equivalent to calling the plot command with only one argument.

The Property Editor

The Property Editor enables you to access a subset of the selected object’s
properties. When no object is selected, the Property Editor displays the figure’s
properties.

Ways to Display the Property Editor
There are a variety of ways to display the Property Editor:

¢ Double-click an object when plot edit mode is enabled.

® Select an object and right-click to display its context menu, then select
Properties.

¢ Select Property Editor from the View menu.
® Use the propertyeditor command.

Changing Plot Types

You can use the property editor to change the type of plot used to display data.
For example, you can change the following line graph to a stem, stairs, area, or
bar graph by changing the Plot Type field.

1-15



T MATLAB Plotting Tools

J Figure 1 101 =l
File Edit ‘iew Insert Tools Deskbop ‘Window  Help u
NeEah2RaN®|€ 08/ oO
1 T = T T T T T T
0.5 -
ok 4
0.5 -
_1 Il 1 Il 1 Il 1 Il
-8 -6 -4 2 0 2 4 6 8
Display Matme: ISine from 0 to 2pi Plot Type: | Line LI Inzpectar .. |
Lirue |
X Data Source: I ® LI Lirme: i 'l Riefresh Data.
Ares
Y Data Source: I\,n' LI Marker: | Stairs g 'l é *'|
Sterm
I Data Source: I LI

Accessing All Object Properties — Property
Inspector

The Property Editor enables you to change the most commonly used object
properties. If you want to access all object properties, use the Property
Inspector. To display the Property Inspector, click the Inspect button on any
Property Editor panel. The following picture shows the Property Inspector
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For descriptions of the properties of graphics objects, use the Graphics

Property Browser.

Accessing Objects You Cannot Click

If you want to access the properties of light or uicontextmenus objects, you need
to get the handle using MATLAB commands, because you cannot click on these
objects.

For example, to get the handles of all light objects in the current axes, use
findobj.

h = findobj(gca, 'Type', 'light');

Then use the inspect command to display the Property Inspector.

inspect(h)

% Inspect all light objects

inspect(h(1)) % Inspect the first light object in list
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Example — Working with Plotting Tools
This example illustrates how to use the plotting tools to graph a workspace
variable vs. an expression typed into the Add Data to Axes dialog.
Create a variable in the workspace,
X = -2*pi:pi/25:2*pi;
Use the plottools command to create a figure with the plotting tools attached.
plottools

Click 2D Axes in the New Subplot panel of the Figure Palette.

File Edit Yiew Insert Tools
NS [k R

w Mew Subplots

20 Axes [ ]

13D Axes »

Once the axes appears, the Add Data button on the Plot Browser is activated.
Click this button to display the Add Data to Axes dialog.

When the Add Data to Axes dialog is displayed, enter the following values:

® Select plot as the Plot Type.

® Set X Data Source to x.

® Set Y Data Source to sin(x)."2.
¢ Click OK to plot this data.

1-18
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<) Add Data to Axes X

Plot Type:

¥ Data Source: I % LI
Optional

Y Data Source: I sinl=)."2 LI

Select a variable, or type an expression

Zancel |

MATLAB draws a plot of sin(x)."2 vs. x.

Now add another plot to the same axes. Click Add Data again and specify the
data to plot:

¢ Set X Data Source to x.
® Set Y Data Source set to sin(x)."8.
¢ Click OK to plot this data.

Select the last plot (the green line) and set the Plot Type in the Property Editor
to Stem. The plot should now look like the following picture.
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Adding a Subplot

Add a second axes below the current axes using the New Subplots panel. Click
the right-facing arrowhead next to 2D Axes and move the mouse to darken two
squares, one on top of the other. This creates a subplot axes below the existing
axes. MATLAB resizes the existing axes so both fit in the figure.
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Once MATLAB inserts the new axes, select its entry in the Plot Browser and
then click Add Data.

When the Add Data to Axes dialog is displayed, enter the following values:

* Set X Data Source to x.
¢ Set Y Data Source to sin(x)."3.
® Click OK to plot this data.

Now add another plot overlaid on the first by clicking Add Data again and
specify the data to plot:

¢ Set X Data Source to x.
¢ Set Y Data Source to sin(x)."9.
® Click OK to plot this data.

Select the plot labeled sin(x)."9 under the second axes in the Plot Browser.
Set the Plot Type in the Property Editor to Area.

Setting Axis Limits
Adjust the x-axis in both axes using the Property Editor.

e Select the first axes in the Plot Browser.
® Change X Limits to -7 and 7.

Repeat these steps for the second axes.
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1-22

Adding Titles and Labels

Select the first axes in the Plot Browser and set the following properties in the
Property Editor:

e Set Title to Even Powers.
e Set X Label to X.
® Click the Y Axis tab and set Y Label to Sine of X.

Select the second axes in the Plot Browser and set the following properties in
the properties panel:

e Set Title to 0dd Powers.

® Set Axis label to Sine of X.

® On the Y Axis tab, set Axis label to Sine of X.

Note that the Plot Browser reflects the new axes names.

The following picture shows the result of these steps.
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Select the text of the y-axis label on the first axes (now labeled Even Powers
in the Plot Browser) and click the Inspector button on the Property Editor. Set

the Rotation property to 0 and reposition the text by hand.

To make more space for the y-axis label, which is now in a horizontal position,

select the axes and move it to the right with the mouse.

Repeat this process for the second axes (labeled Odd Powers in the Plot

Browser).

1-23



T MATLAB Plotting Tools

The repositioned text label now looks like the following picture.
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Note You can always undo your last change to the graph by selecting Undo
from the Edit menu.
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Example — Plotting Workspace Variables

This example shows how to use the Figure Palette to select variables to plot.
Suppose you have three variables in your workspace (x, y, z) created by the
following statements:

[x,y] = meshgrid([-2:.2:2]);

zZ = X.*exp(-x."2-y."2);
You decide to visualize this data as a surface/contour plot (as produced by the
surfc function).

The first step is to display a figure with the Figure Palette tool attached. You
can do this with the figurepalette command.

figurepalette

Expand the Variables panel and shift-click (for multiple selection) on the
three variables you want to pass the plotting function. Since surfc is not in the
list, select More Plots.

w Yariables
[aalx | 21321
= Flok
= Open Seleckion
Save As...
AN Copy Chrl+C
N L Duplicate Chrl+Dr
\ i Delete Delete
Renarme

™0 b yalue

l%l\ T conkour (%, ¥, 2)

T 1 sufix v 2
mesh {x, v, 2)

Llr
gy rocros. ) |
From the Plot Catalog tool, select the 3D Surfaces in the Categories column

and surfc as the Plot Type, as shown in the following picture. To create the
plot, click the Plot button.
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MATLAB creates the following graph.
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Plotting Expressions

You can enter MATLAB expressions in the Plot Catalog tool, as well as
variables. For example, suppose you have created the following variables in the
workspace.

t =0:.01:20;
alpha =.055;

and you want to plot t vs. this expression:
exp(-alpha*t).*sin(.5*t)

The first step is to display a figure with the Figure Palette tool attached. You
can do this with the figurepalette command.

figurepalette

First select the variable t and right-click to display the context menu. Select
More Plots.
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When the Plot Catalog tool is displayed, add the expression to the Plotted
Variables text field. Note that you can reference the variable alpha because
you created it in the base workspace. See MATLAB Workspace for information
about variables in the MATLAB workspace.

<} Plot Catalog

Plotted Variables: It,exp(-alpha*t).*sin('l a4

Categories Plot Types

Stem and Stair Plots

Bar Plots
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Click the Plot button to create the graph. Note that the previous step is the
equivalent of issuing the following command:

plot(t,exp(-alpha*t).*sin(.5*t))
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Example — Specifying a Data Source

Plot objects have properties that enable you to specify the source of the data
that defines the object. For example, you can specify a workspace variable
name or a MATLAB expression as the value of the XDataSource, YDataSource,
or ZDataSource property for a line in a plot (i.e., a lineseries object). You can
then use the Property Editor to change the variable name or alter the
expression, and the plot is updated to reflect the change.

Creating the Graph

First define two variables by issuing these statements in the command
window.

t =0:.01:20;
alpha =.055;

Next plot t vs. the expression exp(-alpha*t).*sin(.5*t) using the plot
function or the plot tools.

plot(t,exp(-alpha*t).*sin(.5*t))

Varying the Data Source

After creating the graph, you can use the Property Editor to couple the plotted
line to the MATLAB expression.

1 Double-click on the plotted line to display its property panel.

2 Enter the MATLAB expression in the Y Data Source text field.
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You can now modify the expression in the Y Data Source text field and observe
how the graph changes. After changing the text, click the Refresh Data button
to update the data.
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In the following picture, alpha is no longer negated, so the function grows
instead of decays. Also the period has been shortened by changing sin(.5*t)
tosin(1.5*t).
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Data Sources for Multiobject Graphs

Suppose you create a line graph from matrix data. For example,
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z
h

peaks;
plot(z, 'YDataSource','z');

Because MATLAB creates one lineseries object for each column of z, the
following is true.

The data source for h(1) is z(:,1).
The data source for h(2) is z(:,2).

The data source for h(n) is z(:,n).
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Example — Generating M-Code to Reproduce a Graph

Suppose you have created the following graph.
t =0:.2:20;
alpha =.055;
stem(t,exp(-alpha*t).*sin(5*t))

You then use the Property Editor to modify the graph to look like the following
picture.

0.8
0.6

0.4

You can generate code to reproduce this graph by selecting Generate M-File
from the Figure menu. MATLAB creates a function that recreates the graph
and opens the generated M-File in the editor.

This feature is particularly useful for capturing property settings and other
modifications made using the plot tools GUI.
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Data Arguments

You must supply the data arguments t and exp(-alpha*t).*sin(5*t) to the
function. Generated functions do not store the data necessary to recreate the
graph.

Limitations

Attempting to generate code for graphs containing a large number of graphics
objects (e.g., greater than 20 plotted lines) might be impractical.
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Editing Plots

MATLAB formats a graph to provide readability, setting the scale of axes,
including tick marks on the axes, and using color and line style to distinguish
the plots in the graph. However, if you are creating presentation graphics, you
might want to change this default formatting or add descriptive labels, titles,
legends, and other annotations to help explain your data.

MATLAB supports two ways to edit the plots you create:

¢ Using the mouse to select and edit objects interactively
e Using MATLAB functions at the command line or in an M-file

Interactive Plot Editing

If you enable plot editing mode in the MATLAB figure window, you can perform
point-and-click editing of your graph. In this mode, you can modify the
appearance of a graphics object by double-clicking on the object and changing
the values of its properties. You access the properties through a graphical user
interface called the Property Editor.

For more information about interactive editing, see “Using Plot Edit Mode” on
page 1-37.

For information about editing object properties in plot editing mode, see “The
Property Editor” on page 1-15.

Using Functions to Edit Graphs

If you prefer to work from the MATLAB command line or if you are creating an
M-file, you can use MATLAB commands to edit the graphs you create. Taking
advantage of the MATLAB Handle Graphics® system, you can use the set and
get commands to change the properties of the objects in a graph.

Note Plot editing mode provides an alternative way to access the properties
of MATLAB graphic objects. However, you can only access a subset of object
properties through this mechanism. You might need to use a combination of
interactive editing and command-line editing to achieve the effect you desire.
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Using Plot Edit Mode

Use these toolbar buttons to add a legend, text, and
arrows.

To start plot edit mode, click this button.
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The MATLAB figure window supports a point-and-click editing mode that you
can use to customize the appearance of your graph. This section describes how
to start plot edit mode and perform basic editing tasks, including

® “Selecting Objects in a Graph” on page 1-38

¢ “Cutting, Copying, and Pasting Objects” on page 1-39

® “Moving and Resizing Objects” on page 1-39

® “Setting Object Properties” on page 1-40

¢ “Saving Your Work” on page 1-42
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Starting Plot Edit Mode

Before you can select objects in a figure by clicking on them, you must activate
plot editing mode. There are several ways to activate plot edit mode:

® Choose the Edit Plot option on the figure window Tools menu.
® Click the selection button in the figure window toolbar.

Click this button to start plot edit mode.

NedaE |k ®&Ra™me |2 0 =8O

® Choose an option from the Edit or Insert menu. For example, if you choose
the Axes Properties option on the Edit menu, MATLAB activates plot edit
mode and the axes appear selected.

® Run the plotedit command in the MATLAB Command Window.
e Start the plotting tools with the plottools command.

When a figure window is in plot edit mode, the Edit Plot option on the Tools
menu is checked and the selection button in the toolbar is depressed.

Exiting Plot Edit Mode

To exit plot edit mode, click the selection button or click the Edit Plot option
on the Tools menu. When plot edit mode is turned off, the selection button is
no longer depressed.

Selecting Objects in a Graph
To select an object in a graph,

1 Start plot edit mode.

2 Move the cursor over the object and click it.

Selection handles appear on the selected object.

Selecting Multiple Objects

To select multiple objects at the same time,
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1 Start plot edit mode.

2 Move the cursor over an object and shift+click to select it. Repeat for each
object you want to select.

You can perform actions on all the selected objects. For example, to remove a
textbox annotation and an arrow annotation from a graph, select the objects
and then select Cut from the Edit menu.

Deselecting Objects

To deselect an object, move the cursor off the object onto the figure window
background and click the left mouse button. You can also shift+click on a
selected object to deselect it.

Cutting, Copying, and Pasting Objects

To cut an object from a graph, or copy and paste an object in a graph, perform
these steps:

1 Start plot edit mode.
2 Select the object.

3 Select the Cut, Copy, or Paste option from the Edit menu or use standard
shortcut keys for your platform.

Alternatively, with plot edit mode enabled, you can right-click on an object and
then select an editing command from the context menu associated with the
object.

Moving and Resizing Objects
To move or resize an object in a graph, perform these steps:
1 Start plot edit mode.

2 For axes objects only: unlock the axes by right-clicking on an empty region
and choosing Unlock Axes Position from the context menu.

3 Select the object. Selection handles appear on the object.
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To move the object, drag it to the new location.

To resize the object, drag a selection handle.

Note You can move text objects, but you cannot resize them.

Setting Object Properties

In MATLAB, every object in a graph supports a set of properties that control
the graph’s appearance and behavior. For example, line objects have properties
that control thickness, color, and line style.

Double-clicking on an object displays the Property Editor. To edit the
properties of the axes or figure, double-click on a region that does not contain
other objects.

See “The Property Editor” on page 1-15 for more information.

Undo/Redo — Eliminating Mistakes

The figure Edit menu contains two items that enable you to undo recent
operation.

Undo — Remove the effect of the last operation.
Redo — Perform again the last operation that you removed by selecting Undo.

For example, if you create a plot, zoom in, pan the view, and then undo the pan
operation, the menu looks as follows:
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Lk Ctrl+§
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Using Plot Edit Mode

You could now undo the previous zoom operation or redo the pan operation you
just undid.
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Saving Your Work

After editing a graph, you can

® Save your work in a format that can be opened during another MATLAB
session

® Save your work in a format that can be used by other applications

Saving a Graph in MAT-File Format

Note To save a figure in a format that is compatible with MATLAB versions
before MATLAB 7, refer to “Plot Objects and Backward Compatibility” on
page 8-20 for more information.

MATLAB supports a binary format in which you can save figures so that they
can be opened in subsequent MATLAB sessions. MATLAB assigns these files
the .fig filename extension.

To save a graph in a figure file,

1 Select Save from the figure window File menu or click the Save button on
the toolbar. If this is the first time you are saving the file, the Save As dialog
box appears.

2 Make sure that the Save as type is Fig-File.
3 Specify the name you want assigned to the figure file.

4 Click OK.

The graph is saved as a figure file (. fig), which is a binary file format used to
store figures.

You can also use the saveas command.

Use the hgsave command to create backward compatible Fig-Files.

If you want to save the figure in a format that can be used by another
application, see “Saving to a Different Format — Exporting Figures” on
page 1-43.
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Opening a Figure File

To open a figure file, perform these steps:
1 Select Open from the File menu or click the Open button on the toolbar.
2 Select the figure file you want to open and click OK.

The figure file appears in a new figure window.

You can also use the open command.

Saving to a Different Format — Exporting Figures

To save a figure in a format that can be used by another application, such as
the standard graphics file formats TIFF or EPS, perform these steps:

1 Select Export Setup from the File menu. This dialog provides options you
can specify for the output file, such as the figure size, fonts, line size and
style, and output format.

2 Select Export from the Export Setup dialog. A standard Save As dialog
appears.

3 Select the format from the list of formats in the Save as type drop-down
menu. This selects the format of the exported file and adds the standard
filename extension given to files of that type.

4 Enter the name you want to give the file, less the extension.

5 Click Save.

Copying a Figure to the Clipboard

On Windows systems, you can also copy a figure to the clipboard and then paste
it into another application:

1 Select Copy Options from the Edit menu. The Copying Options page of the
Preferences dialog box appears.

2 Complete the fields on the Copying Options page and click OK.
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3 Select Copy Figure from the Edit menu.

The figure is copied to the Windows clipboard. You can then paste the figure
from the Windows clipboard into a file in another application.

Printing Figures

Before printing a figure,
1 Select Page Setup from the File menu to set printing options.
The Page Setup dialog box opens.

2 Make changes in the dialog box. If you want the printed output to match the
annotated plot you see on the screen exactly,

a On the Size and Position tab, click Use screen size, centered on page.

b On the Axes and Figure tab, click Keep screen limits and ticks.

For information about other options for page setup, click the Help button in
the dialog box.

To print a figure, select Print from the figure window File menu and complete
the Print dialog box that appears.

You can also use the print command.

Generating an M-File to Recreate a Graph

You can generate an M-file from a graph, which you can then use to regenerate
the graph. This approach is a useful way to generate M-code for work you have
performed with the plotting tools. To use this option,

1 Select Generate M-file from the File menu.
MATLAB displays the generated code in the MATLAB Editor.

2 Save the M-file using Save As from the Editor File menu.

Running the Saved M-File

Most of the generated M-files require you to pass in data as arguments. The
M-file assumes you are using the same data originally used to create the graph.



Saving Your Work

Comments at the beginning of the M-file state the type of data expected. For
example, the following statements illustrate a case where three input vectors
are required.

function createplot (X1, Y1, Y2)
%CREATEPLOT (X1,Y1,Y2)

X1: vector of x data

Y1: vector of y data

Y2: vector of y data

o° of

o°

See “Example — Generating M-Code to Reproduce a Graph” on page 1-34 for
another example.
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Data Exploration Tools

Ways to Explore Graphical Data
(p. 2-2)

Data Cursor — Displaying Data Values
Interactively (p. 2-3)

Zooming in 2-D and 3-D (p. 2-11)

Panning — Moving Your View of the
Graph (p. 2-14)

Rotate 3D — Interactive Rotation of
3-D Views (p. 2-15)

Overview of tools for exploring graph data

Data cursors enable you to read data directly off a graph,
save it in the workspace, and label data points

Behavior of zoom tools in 2- and 3-D

Tool that grabs the graph with the mouse and moves it
within the axes

Move the viewpoint around 3-D objects
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2-2

Ways to Explore Graphical Data

After determining what type of graph best represents your data, you can
further enhance the visual display of information using the tools discussed in
this section. These tools enable you to explore data interactively, eliminating
the need to set the plethora of graphics properties required to achieve the same
results using MATLAB commands.

Once you have achieved the desired results, you can then generate the
MATLAB code necessary to reproduce the graph you created interactively. See
“Example — Generating M-Code to Reproduce a Graph” on page 1-34 for more
information.

Types of Tools

See the following sections for information on specific tools.

¢ “Data Cursor — Displaying Data Values Interactively” on page 2-3

® “Zooming in 2-D and 3-D” on page 2-11

¢ “Panning — Moving Your View of the Graph” on page 2-14

® “Rotate 3D — Interactive Rotation of 3-D Views” on page 2-15

® Camera Toolbar — Interacting with 3-D Views

You can perform data analysis directly on graphs with curve fitting and time
series tools; see

¢ Data Fitting Using Linear Regression

® The Basic Fitting Tool

® The Time Series Tools

These and other topics are covered in the Data Analysis section of the MATLAB
documentation. You can also use cftool if you have the Curve Fitting Toolbox.
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Data Cursor — Displaying Data Values Interactively

Topics in this section:

¢ “Enabling Data Cursor Mode” on page 2-3

® “Selection Style — Select Data Points or Interpolate Points on Graph” on
page 2-8

® “Display Style — Datatip or Cursor Window” on page 2-7

¢ “Exporting Data Value to Workspace Variable” on page 2-9

Data cursors enable you to read data directly from a graph by displaying the
values of points you select on plotted lines, surfaces, images, and so on.

When data cursor mode is enabled, you can

¢ Click on any graphics object defined by data values and display the x, y, and
z (if 3-D) values of the nearest data point.

¢ Interpolate the values of points between data points.

¢ Display multiple data tips on graphs.

¢ Display the data values in a cursor window that you can locate anywhere in
the figure window or as a data tip (small text box) located next to the data
point.

® Export data values as workspace variables.

® Print or export the graph with data tip or cursor window displayed for
annotation purposes.

Enabling Data Cursor Mode

L=
Select the data cursor icon in the figure toolbar I:':— or select the Data Cursor
item in the Tools menu.

Once data cursor mode is enabled, clicking the mouse on a line or other graph
object returns the data value of the point clicked. For example, in the following
picture, the black square is the point selected and the values are displayed in
the data tip next to the point.
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Moving the Marker

You can move the marker using the arrow keys and the mouse. The up and
right arrows move the marker to data points having greater index values in the
data arrays. The down and left arrow keys move the marker to data points
having lesser index values.

Positioning the Datatip Text Box

You can position the data tip text box in any one of four positions with respect
to the data point: upper right (the default), upper left, lower left, and lower
right.

To position the datatip, press, but do not release the mouse button while over
the datatip text box and drag it to one of the four positions.

You can move a datatip using the arrow keys as well as the mouse.
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Dragging the Datatip to Different Locations

You can drag the datatip to different locations on the graph object by clicking
down on the datatip and dragging the mouse. You can also use the arrow keys
to move the datatip.

Click on the square and drag the data tip along
the blue line.

Datatips on Image Objects
Datatips on images display the x- and y-coordinates as well as the RGB values.

5 oo 480 200 250 200 380

Datatips on 3-D Obijects
You can use datatips to read data points on 3-D graphs as well. In 3-D views,
data tips display the x-, y- and z-coordinates.
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Creating Multiple Data Tips

Normally, there is only one datatip displayed at one time. However, you can
display multiple datatips simultaneously on a graph. This is a simple way to
annotate a number of points on a graph.

Use the following procedure to create multiple datatips.

1 Enable data cursor mode from the figure toolbar. The cursor changes to a
Cross.

2 Click on the graph to insert a datatip.

3 Right-click to display the context menu. Select Create New Datatip.
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Customizing Data Cursor Text

You can customize the text displayed by the data cursor using the
datacursormode function. See the Examples section of the datacursormode
reference page for more information.

Deleting Datatips

You can remove the most recently added datatip or all datatips. When in data
cursor mode, right-click to display the context menu.

¢ Select Delete Current Datatip to delete the last datatip that you added.
® Select Delete All Datatips to delete all datatips.

Display Style — Datatip or Cursor Window

By default, the data cursor displays values as a datatip (small text box located
next to the data point). You can also display the data values in a cursor window.
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You can place multiple datatips on a graph, which makes this display style
useful for annotations.

To use the cursor window, change the display style as follows:
1 While in data cursor mode, right-click to display the context menu.
2 Mouse over the Display Style item.

3 Select Window Inside Figure.
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Delete Current Datatin Delete i
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LINESERIES
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Selection Style — Select Data Points or Interpolate
Points on Graph

By default, the data cursor displays the values of the data point nearest to the
point you click with the mouse, and the data marker snaps to this point. The
data cursor can also determine the values of points that lie in between the data
defining the graph, by linearly interpolating between the two data points
closest to the location you click the mouse.

Enabling Interpolation Mode

If you want to be able to select any point along a graph and display its value,
use the following procedure:

1 While in data cursor mode, right-click to display the context menu.

2 Mouse over the Selection Style item.
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3 Select Mouse Position.
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Note that interpolation mode does not work when you are using the arrow keys.

Exporting Data Value to Workspace Variable

You can export the values displayed with the data cursor to MATLAB
workspace variables. To do this, display the right-click context menu while in
data cursor mode and select Export Cursor Data to Workspace.
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MATLAB then displays a dialog that enables you to name the workspace
variable.
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When you click OK, MATLAB creates a structure with the specified name in

your base workspace, containing the following fields:

® Target — Handle of the graphics object containing the data point

® Position — x- and y- (and z-) coordinates of the data cursor location in axes
data units

Line and lineseries objects have an additional field:

® DataIndex — A scalar index into the data arrays that correspond to the
nearest data point. The value is the same for each array.

For example, if you saved the workspace variable as cursor_info, then you
would access the position data by referencing the Position field.

cursor_info.Position
ans =
0.4189 0.1746 0



Zooming in 2-D and 3-D

Zooming in 2-D and 3-D

Zooming changes your view of a graph. Zooming is useful to see greater detail
in a smaller area. Zoom behaves differently depending on whether it is applied
to a 2-D or 3-D view.

Enable zooming by clicking one of the zoom icons ® S . Select + to zoom in
and - to zoom out.

Note, when in zoom in mode, you can use Alt-Click to zoom out (i.e., press and
hold down the Alt key while clicking the mouse).

Zooming in 2-D Views
In 2-D views, click the area of the axes where you want to zoom in, or drag the

cursor to draw a box around the area you want to zoom in on. MATLAB
redraws the axes, changing the limits to display the specified area.

For example, selecting the region of the following plot,

<} Figure 1 . i
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zoom in on

results in a rescaling of the axes to display only that region.
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Undoing Zoom Actions

If you want to reset the graph to its original view, right-click to display the
context menu and select Reset to Original View. You can also use the Undo
item on the Edit menu to undo each operation you performed on your graph.

Zoom Constrained to Horizontal or Vertical

In 2-D views, you can constrain zoom to operate in either the horizontal or
vertical direction. To do this, right-click to display the context menu while in
zoom mode and select the desired zoom option.

Zoom ook AlE-Click:
Reset b Original Wisw

Zoam Options M| v Unconstrained Zoom

Horizonkal Zoom (2-D Plots Only)
Vertical Zoam (2-0 Plats Only)
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Zooming in 3-D Views

In 3-D views, moving the cursor up or to the right zooms in, while moving the
cursor down or to the left zooms out. Both toolbar icons enable the same
behavior. 3-D zooming does not change the axes limits, as in 2-D zooming.
Instead it changes the view (specifically, the axes CameraViewAngle property)
as if you were looking through a camera with a zoom lens.
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Panning — Moving Your View of the Graph

You can move your view of a graph up and down as well as left and right with
the pan tool. Panning is useful when you have zoomed in on a graph and want
to translate the plot to view different portions.

Click this icon on the figure toolbar to enable panning W

2-D vs. 3-D Panning

2-D panning has the effect of changing the axis limits that you are viewing, but
it does not change the actual limits of the plot. For example, suppose you have
a time-series waveform that you want to zoom in on to view detail, but you also
want to be able to scan the entire plot.
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3-D panning moves the axes with the object, because the 3-D view is not aligned
to the x-, y-, or z-axis. The axes limits do not change as in 2-D panning.
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Rotate 3D — Interactive Rotation of 3-D Views

MATLAB enables you to rotate graphs to any orientation with the mouse.
Rotation involves the reorientation of the axes and all the graphics objects it
contains. Therefore none of the data defining the graphics objects is affected by
rotation; instead the orientation of the x-, y-, and z-axes changes with respect
to the viewer.

Enabling Rotate 3D

There are three ways to enable Rotate 3D mode:

® Select Rotate 3D from the Tools menu.
¢ Click the Rotate 3D icon in the figure toolbar @.

¢ Execute the rotate3d command.

Once the mode is enabled, you press and hold the mouse button while moving
the cursor to rotate the graph.

Selecting Predefined Views
When Rotate 3D mode is enabled, you can control various rotation options from
the right-click context menu.

You can rotate to predefined views on the right-click context menu:

* Reset to Original View — Reset to the default MATLAB view (azimuth
-37.5°, elevation 30°).

® Go to X-Y View — View graph along the z-axis (azimuth 0°, elevation 90°).

® Go to X-Z View — View graph along the y-axis (azimuth 0°, elevation 0°).

® Go to Y-Z View — View graph along the x-axis (azimuth 90°, elevation 0°).

Rotation Style for Complex Graphs
You can select from two rotation styles on the right-click context menu’s
Rotation Options submenu:

¢ Plot Box Rotate — Display only the axes bounding box for faster rotation of
complex objects. Use this option if the default Continuous Rotate style is
unacceptably slow.
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2 Do Exploration Tools

¢ Continuous Rotate — Display all graphics during rotation.

Axes Behavior During Rotation

You can select two types of behavior with respect to the aspect ratio of axes
during rotation:

¢ Stretch-to-Fill Axes — Default axes behavior is optimized for 2-D plots.
Graphs fit the rectangular shape of the figure.

* Fixed Aspect Ratio Axes — Maintains a fixed shape of objects in the axes as
they are rotated. Use this setting when rotating 3-D plots.

The following pictures illustrate a sphere as it is rotated with Stretch-to-Fill
Axes selected. Note that the sphere is not round.

<) Figure 1 1 (=] 3]
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The next picture shows how the Fixed Aspect Ratio Axes option results in a
sphere that maintains its proper shape as it is rotated.
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Rotate 3D — Interactive Rotation of 3-D Views
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